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1750 Power Recorder 

Introduction 
The Fluke 1750 Power Recorder is a comprehensive yet easy to use system for 
power quality investigations. The 1750 Power Recorder, referred to hereafter 
as simply “the Recorder”, consists of a power recorder instrument, a wireless 
handheld Personal Digital Assistant (PDA) for control and setup, and a 
powerful yet easy to use PC application, Power Analyze. Four 400 A current 
probes are provided as standard equipment (not included in Basic version). A 
wide range of flexible and clamp-on current probes are available from Fluke. 

Key features of the 1750 Power Recorder are: 

• No PC needed for setup 

Using the included wireless-enabled Personal Digital Assistant (PDA) 
as a controller, you do not need a PC to configure the Recorder, 
troubleshoot connections, preview data, or download the recorded 
data. Downloaded data goes onto the SD memory card plugged into 
the 1750, not directly to the PDA. The range of the PDA with the 
wireless link is about 5 meters (16 feet) from the Recorder. 

• Simplified test lead connections to the power network 

Simply connect a voltage probe to a conductor on each phase that you 
want to record. On the current inputs, the Recorder automatically 
identifies what type of probe is connected. The Recorder then 
configures its measurement system appropriately for the model of 
current probe you are using.  

• Connection diagrams for the supported power network configurations 
(delta, Wye, and others) appear on the handheld PDA controller.  

Once you make connections, you can view live readings and a phasor 
diagram on the PDA to confirm the connections. If a phase channel is 
wired incorrectly, you can swap the phase to another channel by 
changing an internal Recorder setting using the PDA, and then 
reconfirm correct readings. 
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• Internal Uninterruptible Power Supply (UPS) 

An internal NiMH (Nickel-Metal-Hydride) battery pack and charging 
system maintain data capture continuity through power interruptions 
of approximately 5 minutes or less. 

• Automatic disturbance capture 

The Recorder uses an automatic, self-learning threshold routine, 
which means you do not have to set any event threshold limits before 
you start recording. You detect and display power quality events 
(disturbances) using the Power Analyze software on a PC after the 
event has been captured. You define thresholds for events after data is 
stored on the PC. This is called the "event detector" in the software. It 
does not make permanent changes to the data file, so you can 
experiment with different thresholds after the fact without worrying 
about losing data. 

With these features, there is little else required to set up and start recording the 
data to conduct a power quality survey. Should you want to extensively 
analyze collected data, the procedures described later in this manual review the 
transfer of data from the Recorder to the PDA, and finally to a PC. Data may 
then be analyzed using Power Analyze on a PC. Extensive online help is 
provided in the Power Analyze software on the product CD shipped with the 
Recorder. 

Contacting Fluke 
To contact Fluke, call one of the following telephone numbers: 

• Technical Support USA: 1-800-44-FLUKE (1-800-443-5853) 

• Calibration/Repair USA: 1-888-99-FLUKE (1-888-993-5853) 

• Canada: 1-800-36-FLUKE (1-800-363-5853) 

• Europe: +31 402-675-200 

• Japan: +81-3-3434-0181 

• Singapore: +65-738-5655 

• Anywhere in the world: +1-425-446-5500 

Or, visit Fluke's website at www.fluke.com. 
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To register your product, visit http://register.fluke.com. 

To view, print, or download the latest manual supplement, visit 
http://us.fluke.com/usen/support/manuals. 

To contact Technical Support: fpqsupport@fluke.com or 888-257-9897 

Safety Information 
See the Specifications section of the Operators Manual for a full agency 
compliance list. Table 1 lists symbols that appear on the Recorder and in this 
manual. 

Warning 

To prevent possible electrical shock, fire, or personal 
injury: 

• Carefully read all instructions. 

• Do not work alone. 

• Do not use the Product around explosive gas, vapor, or 
in damp or wet environments. 

• Use only insulated current probes, test leads, and 
adapters as supplied with the Product. 

• Examine the case before you use the Product. Look for 
cracks or missing plastic. Carefully look at the 
insulation around the terminals. 

• Remove all probes, test leads, and accessories that are 
not necessary for the measurement. 

• Make sure the ground conductor in the mains power 
cord is connected to a protective earth ground. 
Disruption of the protective earth could put voltage on 
the chassis that could cause death. 

• Only use probes, test leads, and accessories that have 
the same measurement category, voltage, and 
amperage ratings as the product. 

• Do not use exposed metal BNC or banana plug 
connectors. 
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• Do not put metal objects into connectors. 

• Do not operate the Product with covers removed or the 
case open. Hazardous voltage exposure is possible. 

• There are no user-replaceable parts in the Product. 
Have an approved technician repair the Product. 

• Use the Product only as specified, or the protection 
supplied by the Product can be compromised. 

Table 1. Symbols 

Symbol Description Symbol Description 

 
Hazardous voltage. Risk of 
electrical shock. Precedes 
Warning 

 
Risk of danger. Important 
information. See manual. 
Precedes Caution and 
Warning. 

 
Conforms to requirements 
of European Union and 
European Free Trade 
Association (EFTA). 

 

Do not dispose of this 
product as unsorted 
municipal waste. Contact 
Fluke or a qualified recycler 
for disposal. 

 
Canadian Standards 
Association. [ Note: 
Canadian and US. ] 

 Protective conductor 
terminal. 

CAT III 

CAT III equipment is 
designed to protect against 
transients in equipment in 
fixed-equipment 
installations, such as 
distribution panels, feeders 
and short branch circuits, 
and lighting systems in 
large buildings. 

CAT IV

CAT IV equipment is 
designed to protect against 
transients from the primary 
supply level, such as an 
electricity meter or an 
overhead or underground 
utility service. 
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Standard Accessories 
Table 2 describes the standard accessories that ship with the Recorder. Other 
optional accessories are also available. See the 1750 Operators Manual for a 
complete list. 

Table 2. Standard Accessories 

Description Part Number 

Ethernet cable, 3 meters, yellow 2402854 

Colored plastic clips for test leads (32 clips, 8 colors, 4 clips 
each color) 

2157607 

Model TLS430, test lead set including cable and clips  2157713 

Secure Digital (SD) Memory Card for downloading data Contact Fluke 

Model 3140R, 400 A Probes (4 - not included with Basic 
version) 

2277216 

AC power cord, 3 meters 2441360 

Personal Digital Assistant (PDA) with USB cable and 
accessories 

2386780 

CD ROM Manuals and Software 2386771 

1750 Getting Started Guide 2386767 

Sheet of Front Panel Decals 2436261 

Sets of international ac power plug adapters for the PDA 
charger  

2583479 

International adapters for the Recorder power cord 2441372 
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Features 
The Recorder front panel is illustrated in Figure 1 and described in Table 3. 

SD

ETHERNET

POWER

1750 POWER RECORDER

ON

BUSYLINK

100-240 V
  47-63Hz

BA C N

VOLTAGE

CURRENT

4

13

1

2 3

11 10 812

7

5

6

9

 
azd09f.eps 

Figure 1. Fluke 1750 Power Recorder 

Table 3. Input Terminals and Controls 

Number Description 

 Standard 120/240 V 50/60 Hz power input for Recorder power 

 
Voltage indicator 
Steady Voltage is present, not overloaded 
Blinking  Voltage overload (overload threshold 1100 V) 

 Five voltage measurement inputs 

 

Removable Secure Digital (SD) memory card for transfer of large 
quantities of data. You can remove the card from the Recorder, 
insert in the PDA and transfer data to the PC via the “synchronize 
data” feature of the PDA. A USB SD card reader may also be used. 

 

SD status indicator 
Blinking green Reading from SD card – do not remove the card 
Blinking orange Writing to SD card – do not remove the card 
Off No active SD card operation – you can safely 

remove the card 
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Table 3. Input Terminals and Controls (cont.) 

 

Wireless Controller Status Indicator 

Blinking Wireless controller communicating 

Off Inactive 

 

Ethernet port. TCP/IP via Ethernet is used to connect the Recorder 
to a PC for downloading recorded data, and for configuring the 
Recorder when not using the PDA. This is the recommended 
method of data transfer due to its speed and reliability. 

 
Busy Indicator 

Blinking Network is busy 

 

Link indicator 

Off No link 

Steady Link Present 

Blinking Communicating with PC 

 Current Measurement Terminals (5) 

 

Current indicator 

Steady Current probe in normal range 

Blinking >110 % of probe range, use a higher 
range probe 

Off Current insufficient to measure 

 

Red/Green LED 

Steady green AC input power normal, instrument is not 
booted or locked 

Green/Orange blinking Recording 

Blinking red   Recorder running on UPS 

 

Ground Terminal  

Connecting the supplemental ground terminal and the line cord 
safety ground to different ground potentials creates a ground loop 
that can damage the Recorder. To avoid this, use the supplemental 
ground terminal only when no protective earth ground connection 
exists through the line power cord. If there is any chance that a 
safety ground connection does exist through the line power cord 
connection, make sure to connect the supplemental ground terminal 
only to the ground system used by the ac receptacle that powers the 
Recorder. See Figure 2. 
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Caution 

Connecting the supplemental ground terminal and the line 
cord safety ground to different ground potentials creates a 
ground loop that can damage the Recorder. 

Potential
Ground
Loop

Correct,
No Ground Loop

Optional Protective
Chassis Ground

(See detail below)

Different Power System

OK

Line Power Cord

Power Network Being Measured

See     Caution Above

Incorrect,
Creates Ground Loop

GND

N

ØC

ØB

ØA

 
azd11f.eps 

Figure 2. Connecting the Supplemental Ground Terminal 
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Charging the PDA Battery 
Your PDA is shipped with a discharged or partially charged, rechargeable 
battery. You should fully charge the battery before setting up the device, and 
recharge it regularly. Refer to your PDA user’s guide for detailed information 
about the battery. 

Caution 

Do not leave important data on the PDA. If the battery 
discharges completely, you will lose all data not stored in 
File Store (ROM). Discharging the battery completely is 
similar to performing a hard reset. Refer to the PDA Users 
Manual for more information. 

Installing the Software 
This section describes how to install Fluke Power View software on the PDA 
and Fluke Power Analyze software on your PC. Keep your product CD in case 
you need to reinstall this software in the future. You should periodically check 
the Fluke website: www.fluke.com to see if any 1750 firmware or application 
software updates are available for download. Fluke encourages you to register 
the Recorder. After your Recorder has been registered, you will receive email 
notifications of firmware and software update availability. 

Installing Power View on the PDA 

1. Insert the CD that ships with your PDA. Follow the on-screen instructions 
to install the ActiveSync software for Windows XP (or Mobile Device 
Center for Windows Vista and Windows 7) that allows your PC to 
communicate with the PDA.  

2. Connect the PDA to your PC with the USB lead and establish 
communication between the PDA and your PC. Keep your product CD in 
case you need to reinstall this software in the future. 

3. Insert the CD that ships with your Recorder in the CD-ROM drive on your 
PC. 

4. A window appears that lists options on the CD. If the install software 
window does not automatically appear, do the following:  
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a. Use Windows Explorer to locate the sw/FPV_Vx.yy.exe file on the 
CD. Replace x.yy with the current version number shipped on the CD. 

b. Double-click FPV_Vx.yy_Install.exe to launch the installation 
program. 

5. Select a language preference for the installation. 

6. Follow the on-screen prompts. Power View is installed in the Programs 
folder on the PDA. 

7. To start Power View, select Start, and then Programs on the PDA. 

8. Tap the Power View icon ( ) to start using the application. 

Language Selection 

Power View features a localized user interface for English, German, French, 
Spanish, Chinese, and Italian. When Power View operates for the first time on 
a new PDA or after a hard reset, it directly opens the language setup window. 
This window is also accessed by Menu>1750 Setup>Language. 

The Language window also provides the option to choose between the phase 
identifiers A, B, C and L1, L2, L3. 

 
azd110.bmp 
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PC System Requirement for Power Analyze 

• Windows XP, Windows Vista 32/64bit, Windows 7 32/64bit. 
Administrator privileges are required to install applications. 

• PC with 500 MHz or faster processor.  

• 256 MB RAM, 1 GB recommended (100 MB of available disk space, 
10 GB recommended). 

• 1024 x 768 or higher resolution video. 

• Keyboard and mouse. 

Installing Power Analyze  

Before installing the software on your PC, make sure you have Internet 
Explorer version 6, or later, installed. Other recommended software: 

• Adobe Acrobat Reader 

• Microsoft Word 2000 or higher 

• Microsoft Excel 2000 or higher 

Caution 

Do not remove the CD until after you have successfully 
installed the software, rebooted the machine, and opened 
the application. 

1. Insert the CD into your CD-ROM drive. 

2. A window appears that lists options on the CD. If the window does not 
automatically appear: 

a. Use Windows Explorer to locate the sw/FPA_Vx.yy.exe file on the 
CD. Replace x.yy with the current version number shipped on the 
CD. 

b. Double-click FPA_Vx.yy_Install.exe. 

3. Select a language preference for the installation process. Power Analyze 
initially starts in this language. You can change the language from the 
menu Settings>Language. 

4. Follow the installation instructions that appear. After software installation 
is complete, the Power Analyze icon  appears on your desktop. 
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5. Start Power Analyze on your PC by choosing Start >All Programs 
>Fluke >Power Analyze >Power Analyze or double-click the Power 
Analyze icon  on your desktop. 

6. After the installation is complete, please take a few minutes to complete 
your product registration. You can register quickly online (preferred) at 
http://register.fluke.com or you can print the form and fax it to the number 
provided on the form. Product registration is very important since it allows 
you to get free software updates and helps us provide you with the fastest 
and most efficient technical support.  

Note 

You may need to change your Windows firewall settings to allow the 
program FPA.exe to use ports 18571 (TCP) and 18572 (UDP). For 
more on changing firewall settings, refer to 
http://support.microsoft.com.  

Installing the Power Recorder at a Facility 
This section describes the steps you need to take to set up the Recorder at a 
facility and begin a recording session. 

Work Flow 

There are three distinct stages for a recording session. 

• Setup 

Setup, hookup, and verification of connections and measured signals. This 
is when you will want to clear the Recorder memory (not required, but 
best practice because data download when finished only contains your 
new data). This is a good time to change any recorder settings. Edit the 
measurement description now or after downloading the measurement data 
and insert annotations and/or an optional START mark into the recorded 
data stream. Annotations are messages or notes you insert into the data 
stream during a recording session. 

• Interim checkup, mid-recording session 

At this time, you may want to re-check all the live input signals, and 
download the data recorded since the beginning of the recording session. 
This does not interfere with ongoing recording in any way. Annotation 
capability is always available during the recording session. 
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• End of recording session 

You can re-verify if desired, correctness of live data and then download data, 
power off the Recorder, and pack up for transport. 

Installing the Recorder 

1. Position the Recorder within 2 m (6 ft) of the monitoring location. 

2. The Recorder can be set on the floor or a table, or attached and secured to 
a pole or other mounting surface. The Recorder can be oriented vertically 
or horizontally. 

3. Connect the Recorder to a 100 to 240 V ac power source, 50 or 60 Hz. 

4. Plug the power cord into a properly-grounded wall outlet. 

Caution 

To avoid damage to the Recorder: 

• Ground the chassis as appropriate according to your 
power connection before you do anything else. 

• Connect the power cord to the Recorder using the 
appropriate supplied adapter. 

• Connect the power cord to a properly grounded wall 
outlet. 

• Be sure to plug the power cord into the Recorder panel 
BEFORE connecting it to an outlet. 

After a minute, or two, all LEDs should flash ON, then OFF, and then each 
should turn ON and OFF in sequence. The LEDs will then remain on if you 
make secure test lead connections and there is sufficient voltage and current. 

5. Turn on the PDA and tap the Power View icon  to launch Power View. 

If a Recorder is within range and is not password protected, it should 
appear in the drop down menu just below the main title bar on the PDA. 
You may need to select Browse for recorder when first connecting. 
Select the recorder you want to browse to with the PDA stylus. Upon 
selection, the Home screen for live data appears. 
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If more than one Recorder is within range, these will appear in the drop 
down menu list. 

6. If you have previously established password protection for the Recorder, 
you must type the correct password in the Password text box and click 
OK. (Password protection is established for a specific Recorder using 
either the Setup Password menu in Power View or the Power Analyze 
software). 

Connecting the Recorder to the Wiring 

After you have set up the Recorder you are ready to connect the voltage leads 
and current probe or flexi-probes to the power network being tested. Refer to 
the Power Type diagrams provided on the PDA or in this manual. 

Warning 

To prevent possible electrical shock, Flexi-probes should 
not be applied or removed from hazardous live 
conductors. 

In most cases, you should install the current probes first. Because they are 
clamped around wires, current probes are usually more secure than voltage 
probes. Examine the conductors you are about to connect to and determine if 
you should attach the current probes to the phase wires or busbars before you 
connect the voltage probes.  

1. Select and attach the appropriate current probes to the Recorder. 

2. Select and attach the appropriate voltage test leads and probes to the 
Recorder. 

Note 

If your power connections require potential transformers (PTs) or 
current transformers (CTs), you can use the ratio settings in Power 
View to set the Recorder to display readings as they exist on the 
primary side of the PT and CT (for example, 12000 V). 

3. Connect the Recorder to the wiring by first connecting the measurement 
ground test lead to the distribution system ground, and then the neutral 
probe to neutral. 



 Power Recorder 
 Installing the Power Recorder at a Facility  

  15 

4. Connect the ground current probe to the distribution system ground and 
the neutral current probe to neutral, with the arrow on the current probe 
pointing towards the load (away from the source) in each case. 

5. Connect the remaining current probes to the power network.  

• The arrow on the current probe should point toward the load. 

• Use the color-coding on the leads to help you connect the probes to 
the correct phases, neutral and ground.  

6. Connect the remaining voltage probes. 

Note 

Make sure the voltage probes and current probes are paired 
correctly, Phase A (L1) voltage to Phase A (L1) current and so forth. 
Calculations are made in pairs and cannot be changed after data is 
recorded. The leads for the voltage probe and current probe of the 
same color should be attached to the same phase wire or busbar. 

7. Check the LED for each phase to make sure a connection is established.  

• When a phase LED is ON or lighted, you know that the connection is 
active and that voltage and current is within the normal range.  

• When a phase LED is BLINKING, you are connected but the voltage 
or current is exceeding the normal range or exceeding the range of the 
probe that you are using. 

• When a current LED is OFF or unlit, there is insufficient current 
present in the line. 

Verifying Your Connection 

Before you leave the Recorder to accumulate data at the facility, double-check 
the connections.  

• Make sure the current probes are secured and completely closed 
around the conductors and that the voltage and current LEDs are 
steady-on. 

• Use the PHASOR screen on the PDA or PC to verify that the voltage 
and current connections are correct. You can swap the connections 
using Power View if they are incorrect. 
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Finishing Up 

After making any corrections to the connections, recheck the PHASOR 
diagrams to confirm your connection. Make sure the nominal voltage, nominal 
line frequency, and power type (delta, wye, other) are correct before you leave 
the Recorder. It is a good practice to insert a Start Mark when you are finished 
with all settings so you can download data and ignore useless readings and 
events common at the beginning probe connecting activities. You can also use 
the “Erase Memory” function and measurement descriptions such as 
company, name, and measurement purpose. This can be done at this point or 
after downloading the measurement data. 

Managing Recorded Data 

Recorded data resides in the Recorder on an internal non-physically accessible 
flash memory circuit. The transfer of recorded data to the SD card in the 
Recorder’s SD slot is automatic when you insert the SD card or you request a 
download action using the PDA. Downloading to a PC running Fluke Power 
Analyze Software (included) using the Ethernet cable is recommended and the 
fastest way to retrieve data from the Recorder. 

Note 

To stop the automatic copy from the SD card memory, go to Menu 
>Tools >1750 Internal Memory or Menu >Tools >1750 SD 
Memory. 
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Downloading Data and Erasing Memory 
Use the Data menu options to manage the Recorder memory and download 
recorded data to the SD card plugged into the Recorder's (not the PDA) SD 
card slot. You are downloading recorded data from the flash memory to an SD 
card in the Recorder. When you want to use that data, you must move the card 
to the PDA. You can later copy the data to your PC for review using the Power 
Analyze software.  

Auto Download 

The Auto Download feature copies all recorded data to the SD card without a 
PDA or PC. Auto Download starts when you insert the SD card and have no 
connection to Power View or Power Analyze. The SD card status indicator 
flashes while a copy of the data moves to the SD Memory card.  

Note 

Do not remove the SD card while the SD status indicator is 
flashing. The SD card can be safely removed when the SD status 
indicator is off. 

To stop the automatic download with Power View, select either 
Menu>Tools>1750 Internal Memory or Menu>Tools>1750 SD Memory.  

If the download does not start automatically: 

1. Verify that neither Power View nor Power Analyze is connected to the 
device. 

2. Watch the SD status indicator. As soon as an SD card is inserted, the 
indicator flashes green for a short time. This is the indication that the 
device has recognized the SD card. If nothing happens the SD card is not 
compatible with the Fluke 1750. 

3. Check to see if the SD card is write-protected. Make sure the slider on the 
card is not in LOCK position. 

If the SD status indicator flashes when the SD card has been inserted but it 
does not flash for a longer period of time (>1 second) the available space 
may be insufficient. Use a new, empty card or delete files on the SD card 
with the use of the PDA or a card reader. 
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PDA Download 

Tap 1750 Internal Memory in the Data menu to view the Download screen. 

 
azd116.bmp 

The Download screen shows a three-phase rms V strip chart with date and 
timescale shown. This represents the data in the Recorder internal memory. 
The default settings of the start and stop times is everything in memory. To 
download ALL, tap the Write to SD button. If you want to trim off data that 
contains partial information because probes were being connected, select the 
START mark annotation (if one was entered by the user) as the start point. 

The gray cursor lines right and left with triangular arrowheads at the bottom of 
the screen show the start and stop times currently selected for download. Green 
and red flags are START and STOP mark annotations inserted during the 
recording session. Yellow flags are file name annotations inserted during the 
recording session, or setup parameter changes that change the data 
significantly, such as nominal voltage or power type. 
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If the SD storage card already contains data files, it may not have room for the 
new download. Power View alerts you to this condition and asks if you would 
like to erase the SD card before downloading.  

 
azd107s.bmp 

You can also access the SD card to delete files by selecting 
Menu>Tools>1750 SD Memory. 
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You can delete files as necessary, and when satisfied that there is room on the 
card, proceed to write the selected internal Recorder memory data to the 
SD card. 

 
azd108s.bmp 

When there is room on the card, a message confirming the download will 
appear. 
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You can also tap the Erase 1750 Memory from the Data menu option which is 
available under Menu, and tap the Erase All button to erase all power quality 
data stored in the Recorder. Even then, if you want, you can leave old data in 
Recorder memory. It will be overwritten automatically when you start your 
next Recorder session, so it never has an adverse effect on recorded data 
quality or quantity. 

 
azd109s.bmp 

 

When you choose to Erase All, the following popup caution “Are you sure?” 
appears on the screen. 
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Note 

You can also download data by connecting your PC directly to the 
Recorder with an Ethernet cable and run Power Analyze in the 1750 
Live mode. All of the functions (controller, PDA, and Power View) 
are duplicated in 1750 Live mode. 

Power Type Diagrams 
Power type diagrams are provided on Power View and Power Analyze and can 
be referenced when you are setting up nominal power on the Recorder. The 
diagrams are used an aid in making the correct test lead connections. The 
following power type diagrams are for the standard power configurations: 

• One-Phase Plus Neutral 

• One-Phase IT No Neutral 

• One-Phase Split Phase 

• Three-Phase Wye 

• Three-Phase Delta 

• Three-Phase IT 

• Three-Phase High Leg 
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• Three-Phase Open Leg 

• 2-Element Delta 

• 2 ½-Element Wye 

Using Fluke Power Analyze 
In addition to analyzing data that has already been recorded, you can also 
connect to a Recorder through Power Analyze. When you do this, all of the 
features available through the PDA are also available directly on your PC. For 
example, you can: 

• View live data by connecting to a Recorder connected to power. 

• Configure a 1750 Power Recorder to which you are connected. 

• Add annotation markers and take manual snapshots that are then 
stored in the Recorder. 

Fluke Power Analyze software lets you work on your PC with power quality 
data monitored by and received from the Recorder. With Fluke Power 
Analyze, you can download, review, and analyze data. For example, you can: 

• Download data from a Recorder into a data file on your PC, or open a 
file that was downloaded previously and moved to your computer. 

• Analyze the data you have downloaded using a series of views to see 
different aspects of it, including summary graphs of Summary, 
events, harmonics, THD, flicker, power and energy.  

As you review the data on the Power Analyze screens, you can adjust 
the data shown by turning on and off display of different channels and 
select other parameters. You can focus on the specifics that help you 
analyze and understand the power quality data. 

• See snapshots of the recorded power quality data at specific points in 
time as though you had looked at the measurements while they were 
live.  

Because snapshots are captured at regular intervals, you can advance 
through them and review the measurement as they were at successive 
points in time. 
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• Build reports with a single click. Store the report configuration for 
reuse. Document important data as you identify it in the recorded data 
files. 

This section of the Getting Started Guide describes how to begin working with 
Power Analyze software to review and analyze data in recorded data files. Use 
it to become familiar with the Power Analyze interface and features. Detailed 
information for is available in the Power Analyze online help. 

Getting Answers to Questions as You Work 
As you work with Power Analyze, you can use Online Help to get detailed 
information about how to use the software to examine recorded data, connect 
to instruments and view live data, download data, and other tasks. You can 
access the online help system included in Power Analyze in several different 
ways.  

In the main window, click the Help question mark  on the toolbar and then 
click an item on the screen to get information about that item. You can use this 
to find information about buttons and other items on the toolbar, commands in 
menus, and the main screens.  

For information about the current view, or for help in a dialog box, click 
. You can also see this information by pressing the F1 key.  

You can also open the help system by choosing Help Topics from the Help 
menu.  

Once Help is open, you can use the Contents, Index, and Search tabs on the 
left to help you locate information.  

If the Help window is too wide, you can hide the navigation pane on the left by 

clicking  at the top of the Help window. To open the navigation pane again, 

click .  

Starting Power Analyze 
You can start Power Analyze on your PC by choosing Start >All Programs 
>Fluke >Power Analyze. 

As you learn to use Power Analyze, you can use the file named 
SAMPLE.ODN until you have a data file you want to analyze. 
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Working with Recorded Data Files 
You work in the Fluke Power Analyze works with one file at time. When you 
download data, it is stored in a file with the extension ".odn". When you 
download using Power Analyze, these files are stored by default in the 
directory “\My Documents\Fluke\Power Analyze\”. If you move downloaded 
data from the Recorder to the PC via an SD card, you can copy the .odn file 
either to this Power Analyze directory or to another folder. For information 
about moving downloaded data to your PC, see “Moving Downloaded Data 
from the Recorder to a PC” later in this manual  

To start Fluke Power Analyze and open a file at the same time 

1. In the Windows Explorer or on your desktop, locate the .odn file you want 
to open. 

2. Double-click the file to open the file in Fluke Power Analyze.  

To open a data file when Fluke Power Analyze is already open  

1. From the File menu, choose Open.  

2. In the Open dialog box, navigate to the file you want to open, select it and 
click Open.  

The file opens in a Fluke Power Analyze window and displays the Summary 
view. The name of the file appears in the application title bar. For details about 
the Power Analyze window, see “Overview of the Power Analyze Screen” 
later in this manual. 

Moving Downloaded Data from the Recorder to 
a PC 
The procedure below describes how to download recorded data from the SD 
card to your PC to analyze recorded data using Power Analyze. 

To move the downloaded data from an SD card to your PC: 

1. Download the data from the Recorder’s internal flash memory to the SD 
storage card. 

2. Insert the SD storage card into the SD card slot on the PC, if available, or 
SD card reader. 

3. Copy the measurement files to a known location. 

To move the downloaded data from an SD card to your PDA: 

1. Insert the SD card into the PDA. 

2. Connect the PDA to your PC with the USB cable. 
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The SD card should display as an additional drive storage card for the 
PDA in the My Computer folder. 

3. On your PC, open the card as a drive.  

4. Copy the files from the PDA to the desired location on your computer.  

You are now ready to open the recorded data files in Fluke Power Analyze.  

Overview of the Power Analyze Screen 
Whether you are working with a recorded data file or are connected live to a 
Recorder, many of the elements of the Fluke Power Analyze screen are the 
same.  

Power quality data appears in the central screen area. The type of data you see 
depends on the active mode and view. Additional view controls on the right 
side and buttons on the tool bar let you customize how the data displays.  

Figure 3 shows the Summary recorded data view and Table 4 describes the 
areas and controls of the screen. For a detailed review of the contents of the 
actual data, see “Recorded Data Screen Overview” later in this manual. 
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Figure 3. Power Analyze Screen 
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Table 4. Power Analyze Screen Areas and Controls 

Number Description 

 
Connected Recorder. When you are connected to a 1750 Power 
Recorder, this field shows its name. A drop-down list shows other 
Recorders to which you can connect. 

 
Name of data file. When you view recorded data, the name of the 
".odn" file appears in the window title bar. 

 

Help buttons. Several types of online help are available for Fluke 
Power Analyze. Two are shown on this screen. For details about 
accessing Help, see “Getting Answers to Questions as You Work” 
earlier in this manual. 

 

Main Data Area. The central part of the screen shows the power 
quality data for the active mode and view. You can make further 
adjustments to the data displayed by using the view controls and 
tool bars. 

 

View toolbar. Provides quick access to the different power quality 
data views for the active mode (Recorded Data, Snapshots, or 
Live 1750 Data). The active button on the View toolbar indicates 
the view you see now. 

 
View controls. View controls specify what data to display in the 
view, and how it should appear. 

 
Status Bar. Shows the power configuration, nominal voltage, and 
frequency for the data you are viewing. When viewing live data, it 
also shows the name of the Recorder.  

 

Power Analyze Mode Side Bar. Mode buttons activate different 
sets of views and screens in Power Analyze. The active button 
indicates the mode in view. In the screenshot example, View 
Recorded is active. For more information, see “Overview of the 
Power Analyze Modes” later in this manual. 

 
Main tool bar. Frequently used actions appear as buttons on the 
toolbar. 

 
Menu bar. Menus provide access to Power Analyze commands. 
Frequently used menu items are also available on the main 
toolbar and view toolbars. 
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Overview of the Power Analyze Modes 
There are six modes in Fluke Power Analyze, all 
available from the side bar at the left of the screen. The 
top three allow you to work with recorded data that has 
been saved as a data file, while the bottom three let you 
work with live data when you are connected to a 
Recorder. 

Recorded Data Modes  

These modes are available when a recorded data file 
(.odn) is open.  

• View Recorded lets you analyze data that has 
been downloaded from a Recorder and saved as 
a data file.  

• Auto Report lets you create user-configurable 
reports of downloaded data in MS Word or PDF. 

• View Snapshots displays snapshots of measured 
power conditions taken manually or on a 
periodic basis throughout the monitoring period 
and stored in the recorded data file.  

• View Settings displays the Recorder settings 
that were in effect when the recording was 
made. This includes power configuration, 
nominal voltage and frequency, voltage and 
current ratios, and other connection factors. 

 
azd246.png 

Live Data Modes  

These modes are available when connected to a Power Recorder.  

• 1750 Setup lets you view and set the instrument settings, including 
the power configuration, nominal voltage and frequency, voltage and 
current ratios, and other details about the data that is recorded before 
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starting a recording session. You can also create a password in this 
mode. 

• 1750 Live lets you monitor data directly, when you are connected to a 
Recorder. 

• 1750 Download lets you retrieve data from the Recorder and save it 
on your computer.  

Recorded Data Screen Overview  
Recorded data views are the primary screens you work with when analyzing 
power quality data. Five different views of recorded data are available: 
Summary, Volts/Amp/Hz, Events, Harmonics, THD, Flicker, and 
Power/Energy. Figure 4 shows a sample Recorded Data Screen and Table 5 
describes the contents of the screen. 

In many of the recorded data views you see both a Reference graph and a 
Detail graph. The reference graph shows the full range of available data. The 
detail graph shows a subset of that data. For more information about the screen 
menu and buttons, refer to the section “Overview of the Power Analyze 
Screen” earlier in this manual. 

When you work with recorded data, many of the elements on the screen are the 
same regardless of which view is displayed. 

Note 

Check the Fluke website (www.fluke.com) for updates. 
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Figure 4. Recorded Data Screen 
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Table 5. Recorded Data Screen Contents 

Number Description 

 
Name of open data file. Shows the name of data file that is 
presently open. 

 
Reference graph. Provides an overview of the data for the entire 
recorded period. 

 
Detail graph. Shows a detailed view of a portion of the recorded 
data, determined by the selection cursors on the top graph.  

 
Selection cursors. The selection cursor bars mark the data 
shown in the Detail graph. As you move the cursor bars, the data 
in the detail graph adjusts.  

 
View toolbar. Lets you change between recorded data views. The 
active button indicates the view you see now. In the screenshot 
above, Volts/Amps/Hz is the active view.  

 

View controls. Specify data to be displayed in the view, and how 
it should appear. For example, on the Volts/Amps/Hz graph shown 
above, view controls let you hide or show phases, select whether 
maximum values are shown, or show or hide annotations. 

 
Status Bar. Shows the power configuration, nominal voltage, and 
frequency for the data you are viewing.  

 
Measurement guides. This set of guides let you measure data in 
the Detail graph. The measurement value is shown on the boxed 
labels between the guides. 

 
Graph toolbars. Provide access to tools you can use with graphs, 
such as showing and hiding the guides, or zooming in on data. 
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1750 Live View Screen Overview  
When you are connected to a Recorder, five different views of the live power 
conditions are available. You can see this same information using Fluke Power 
View on the PDA. Figure 5 shows a sample Live View Screen and Table 6 
describes the contents of the screen. 

Although the format of the 1750 Live views vary, the overall structure of the 
live screens is the same. The screenshot below shows the essential elements in 
the live Scope view. For more information about the Scope view and other 
1750 Live views, see the Online Help.  
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Figure 5. Live View Screen 
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Table 6. Live View Screen Contents 

Number Description 

 
Connected recorder. Shows the name of the Recorder to which 
you are connected.  

 
Main data area. Displays the power quality parameters you are 
viewing: Scope, PHASOR diagram, meter, harmonics, or power. 

 
View toolbar. Lets you change between live views. The active 
button indicates the view you see now. In the screenshot above, 
Scope is active. 

 
View controls. Specify what data to display in the view, and how 
it should appear. 

 

Status bar. Shows the 1750 setup, including Recorder name, IP 
address, power configuration, nominal voltage, and frequency. 
You can set this information using the 1750 Setup mode, or using 
Power View on the PDA. For more information setting up a 
Recorder through Power Analyze, see the Online Help. 

Snapshot Screen Overview  
Snapshots are screen captures at a single point in time of the measurements 
made by the Recorder as displayed in 1750 Live mode. When you download 
data, you download snapshots (taken manually and at regular intervals), along 
with the long-term summary data and events. All five views that are available 
for live power are also available in the snapshot views, giving you a detailed 
view of conditions at specific intervals.  

When you first display the Snapshot views, you see the first snapshot taken in 
the downloaded data. You can use the Slider Bar or the Next/Previous buttons 
to bring additional snapshots into view.  

The interval at which snapshots are captured is specified when the Recorder is 
set up. In addition, a snapshot can be taken manually using the PDA or using 
the Take Snapshot button.  

Figure 6 shows the main elements in snapshot views. More detail on specific 
snapshot screen elements are described in Table 7. 
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Figure 6. Snapshot Screen 

Table 7. Snapshot Screen Contents 

Number Description 

 Data filename. Shows the name of the data file presently open. 

 

Main data area. Displays a snapshot of the conditions at the 
date and time shown in slider bar. In this example, the snapshot 
is of the Scope for the phases checked in the Phase Selection 
area of the view controls. For details about the contents of the 
different snapshot views, see the Online Help. 

 
Slider bar. Allows you to move to a snapshot at a different point 
in time within the recorded data by dragging the slider. 

 
View toolbar. Lets you change to different Snapshot views: 
Scope, Phasor, Meter, Harmonics, and Power. The active button 
indicates the view you see now. 
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Table 7. Snapshot Screen Contents (cont.) 

Number Description 

 
Next/Previous buttons. Lets you move through snapshots one 
at a time by clicking these buttons.  

 
View controls. Specify data to be displayed in the view, and 
how it should appear.  

 
Status bar. Shows the power configuration settings at the time 
the data was recorded.  

Working with Snapshots 
Snapshots are captured at regular intervals, based on the Snapshot Interval set 
in 1750 Setup. You can also capture snapshots manually using the Take 
Snapshot button on the Power Analyze toolbar in 1750 Live Mode, or using 
the wireless PDA with the Recorder. Snapshot data is saved in the Recorder 
and downloaded with the rest of recorded data. 

When viewing at Snapshot screens in Power Analyze, two tools are available 
to move through the available snapshots: 

• The Slider bar appears at the top of each Snapshot view.  

 
bae044s.bmp 

Press and drag the slider bar to the point in time for which you want 
to see power conditions.  

The snapshot data closest to this point in time is shown in the 
Snapshot view.  

• The Next/Previous buttons ( ) appear at the top of the View 
controls. 

Click these buttons to move to the next snapshot in either direction.  
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Main Toolbar 
The main toolbar in the Power Analyze window includes standard Windows 
tools and some specialized buttons for working with Fluke Power Analyze 
graphs. Figure 7 shows the Main Toolbar and Table 8 describes the contents of 
the toolbar. 

Hide or show the toolbar by choosing View >Toolbar.  

Note 

The tools on the main toolbar all have a corresponding topic on a 
menu.  
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Figure 7. Main Toolbar 

Table 8. Main Toolbar Contents 

Button Description 

 Open. Opens a recorded data file.  

 
Top Full Screen View. Expands the top graph to fill the graph 
window area.  

 
Bottom Full Screen View. Expands the lower graph to fill the 
graph window area.  

 
Split Screen View. Displays a reference graph on the top and a 
details graph in the bottom of the graph window area.  

 
Top Table View. Toggles the display of the data in the top 
reference graph from graph to table and then back.  

 
Bottom Table View. Toggles the display of the data in the bottom 
detail graph from graph to table and then back.  
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Table 8. Main Toolbar Contents (cont.) 

Button Description 

 
Take Snapshot. Takes a snapshot of the current power 
measurements. Available only in 1750 Live views. 

 
Insert Annotation. Inserts an annotation marker. Available 
only in 1750 Live views 

 

Help. Lets you get information about buttons on the screen and 
commands in the menus. Click the Help tool button and then 
the item you want information about. For information about the 
contents of the main graph area, click the Help button at the top 
of the Graph controls on the right side.  

 
Window List. Lets you switch between multiple windows in the 
same recorded data file. 

Graph Toolbars 
When you view data on graphs, special toolbars are available to help you work 
with that data. Figure 8 shows a sample Graph Toolbar and Table 5 describes 
the contents of the toolbar. 

The particular tools available vary depending on the contents of the graph. The 
screenshot below shows some of the tools that appear on graph toolbars, and 
more detailed information about specific features follows that. 
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Figure 8. Graph Toolbar 
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Table 9. Graph Toolbar Contents 

Button Description 

 Zoom All the Way Out. Zooms out to display the full graph. 
Active only after you have zoomed in on a portion of a graph.  

 
Zoom Out. Zooms out on the graph keeping the same graph 
center. 

 
Zoom In. Zooms in on the graph keeping the same graph center.  

 
Select. Lets you select annotation markers in graphs on the 
Summary view and the Events view. When you select this tool 
Zoom becomes inactive. 

 
Guide. Shows or Hides the guides on a graph. 

 
Copy. Copies the current graph to the Clipboard. 

Zooming In and Out On Graphs 
Sometimes the amount of data shown on a graph makes it hard to clearly see 
the detail you need to analyze power quality data. When this is the case, you 
can zoom the graph to magnify your view of the data. A combination of 
zooming and scrolling can often be used to focus on the specific information 
you need.  

Several zooming tools are available: the Zoom Box and Zoom In/Zoom Out 
buttons on the graph toolbar, and the Auto Scale and Manual Scale 
commands on the right-click menu (available when you point to either the 
horizontal or vertical axis).  

To zoom in and out incrementally in the graph toolbar, click  and .  

To zoom in on a section of a graph with the Zoom box:  

1. If it is not already active, click . 

2. Draw over the section of the graph you want to see in more detail. 

Fluke Power Analyze zooms in on the area you marked and centers it in 
the window. 
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The selection cursors on the Reference Graph shift to mark the new 
selection.  

3. If the information you want is not quite centered, you can scroll the graph 
horizontally or vertically.  

Note 

You can zoom in multiple times on an area of a graph. If the graph 
area appears blank, you may have zoomed outside the range of data.  

To zoom out 

• If you want to zoom out incrementally, click .  

• If you want to zoom back to 100 % size, click . 

To use Auto Scale: 

You can automatically zoom the available data to the size of the graph window 
by using Auto Scale.  

Auto Scale can be used based on either the Y-axis or the X-axis: 

1. Right-click on the axis you want to resize. 

2. Choose Auto Scale from the right-click menu. 

The available data zooms to the size of the window, based on the axis 
where you right-clicked. If appropriate, the axis will adjust to match the 
range of data.  

In the Harmonics and THD views, using Auto Scale on the x-axis of the 
Harmonics Spectrum graph will display all 50 harmonics in the graph 
window at once. 

You can define the range of the axis by using Manual Scale. Manual scale is 
supported on the vertical scale and time axes.  

To use Manual Scale: 

1. Right-click on the axis to resize. 

2. Click on Manual Scale. 

3. Enter the minimum and maximum value of the range. 

When the Manual Scale is applied on the Y-axis, the dialog box displays 
the minimum and maximum value of the available data for information. 
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Using the Manual Scale on the time axis allows you to enter either the 
start and end date or the start date and a time span from a predefined list. 

4. Click OK to apply the changes. 

Screen View Tools 
When you first view recorded data, the views show two types of data in a split 
view format. Figure 9 shows a sample Screen View Tools and Table 10 
describes the tools. 

For most views, the data includes reference data, which gives a broad view of 
the recorded data, and detail data in the display’s top half, which appears in the 
bottom half of the display.  

Options on the left toolbar let you expand either set of data to fill the window. 

Note 

 This feature also works when you are displaying as a table either the 
top or bottom set of data. 
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Figure 9. Screen View Tools 

Table 10. Screen View Tools 

Button Description 

 
Click to see the top full screen view. 

 
Click to see the bottom full screen view. 

 
Click to see both graphs again. 

Viewing Data as a Table 
In most recorded data views, you can view data in table format as well as in 
graph format. This is useful for studying results in the form of digital readings, 
or preparing tabular data for a report. 
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When you switch to the table display, the tables generated remain on the 
screen even as you change recorded data views, until you turn off the table 
display and switch back to graphs.  

Note  

If you click the Tag for Report button when a table is in view, the 
portion of the table in view will be included in your next report. (For 
more information, see “Building a Report” later in this manual.) To 
print all of the data in the table, first export it to a spreadsheet.  

To toggle between graph and table views: 

You can toggle between graph and table views for the top graph, the bottom 
graph, or both graphs.  

• Click one of the Table tools  to display the upper or lower 
graph as a table. 

• Click the Table tool again to return to the graph display shown in 
Figure 10.  
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Figure 10. Graph Display 

To sort the data in a table: 

• When you view Events in a table, you can sort the tables by clicking 
the header for the column you want to sort by.  

To maximize a table to full size: 

• Click the Top Full View button or the Bottom Full View button 
( ), depending on which table you want to view full size. 
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Working with Annotations 
Annotations are optional markers that can be inserted by the Recorder operator 
to flag a particular point in the data when recording. They are usually inserted 
on using Power View with the wireless PDA. Figure 11 shows a sample 
Annotation View screen. 

Annotations can be used to help select what data to download, and to provide 
additional information when reviewing recorded data in the Summary view.  
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Figure 11. Annotation View 

There are five types of annotations:  

• Start annotation (green) 

The Start annotation can be used to signify where important data 
begins. For example, the operator might want to establish a start 
annotation after having finished all probe connections and instrument 
setup, to indicate that any preceding data was preliminary.  

Note 

You are not limited to using the Start and Stop annotations in pairs, 
or to show a range of data. You can use each as many times as 
desired to mark a particular point during recording.  

• Stop annotation (red)  

The Stop annotation can be used to signify where important data 
ends. 
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• File annotation (yellow) 

File annotations contain the name of a picture or audio file relevant to 
the data. See “Using Image or Voice Annotations” later in this 
manual. 

• Text annotation  

Text annotations contain a text note.  

• Power Configuration Change annotation  

Power Configuration Change annotations are inserted by the system 
when a change is made to the Power Configuration in the Recorder. 
These markers only display in the Download dialog box. 

To show or hide annotation markers  

• In the Summary or Events view, check or uncheck the Annotations 
option on the view controls. 

To open an annotation 

• In the Summary view, Events view, or Download dialog box, click on 
the annotation.  

If the annotation is associated with an audio (.WAV) or image (.jpg) 
file, the application associated with that file will start and open the file. 
If the file is not in the default directory \My Documents\Fluke\Power 
Analyze, a dialog box opens so that you can navigate to the file. 

Note 

If clicking on an annotation marker does not seem to do anything, the 
Zoom box is probably selected in the graph toolbar, instead of the 
Select tool. Click the Select tool and then select the annotation. 

To see overlapping annotations 

Sometimes annotations are so close to each other that they actually overlap on 
the Summary reference graph. When this is the case, if you click on 
overlapping annotations, a menu opens and you can select either Open, to open 
the annotation now on top, or Select Next Overlapping Annotation, to bring 
the next one to the top.  

• To open the annotation now on top, choose Open. 
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• To bring the next annotation to the top, choose Select Next 
Overlapping Annotation. To then open that annotation, click on it 
again and choose Open. 

Note 

To see overlapping annotations more clearly on the Summary 
reference graph, move the selection cursors so that they just surround 
the area that contains the overlapping illustrations. The Detail graph 
adjusts as the cursors move, zooming in to show the area between the 
selection cursors. You can now see the annotations separately.  

Using Image or Voice Annotations 

While you are monitoring data with a Recorder, you may find it helpful to take 
a picture that relates to the power quality data you are recording, or to record 
verbal comments as you observe the conditions or review the data being 
measured. You can then associate the image or recording with the data being 
recorded by adding annotations that reference them.  

The PDA includes a microphone for recording notes which are saved as .WAV 
files, and an optional camera accessory is available on the PDA which will 
capture images as .jpg files.  

You can associate both images and audio files with the data being gathered in 
the Recorder by inserting annotations and specifying the name of a .WAV or 
.jpg file. After you download data from the Recorder, you can then move the 
image and audio files to the PC along with the recorded data (.odn) file.  

Note 

You can also associate other types of files with the annotation. For 
example, if you had an .MPJ file with a movie, or a .DOC file with 
associated information. You can enter any file name using this 
annotation method. 
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Inserting Image or Voice Annotations  

1. Set up the Recorder and begin monitoring. 

2. Using your PDA-cam or another camera, take a picture of what you want 
to capture. 

3. In Power Analyze, go to 1750 Live mode and click  to open the 
Annotate dialog box.  

Or on your PDA, in Power View, click the Annotate icon to display the 
Annotate screen.  

4. Select Insert File. 

5. Browse to find the picture file (for example, IMG_2435.jpg) or audio file 
(for example, voice_123.wav) and select it; then click Insert.  

The file name you specified is inserted into the data and associated with 
the present date and time (and therefore, the present power 
measurements).  

Managing Image and Voice Files 
If you are using the PDA, move the image or audio file to a location that will 
make it easier to Transfer it to a PC later, when you download and move the 
recorded data file to your PC. You can accomplish this in two ways:  

• Place the file into the synchronization folder on your PDA, so that it 
will be automatically transferred into the sync folder on the PC the 
next time you dock the PDA. 

You may find this approach useful if you download data using Power 
Analyze on your PC. After synching the files from your PDA, be sure 
to move the annotation files into the folder that contains your .odn 
files (by default, \My Documents\Fluke\Power Analyze). 

• Transfer the file onto an SD card for later transfer to your PC.  

If you use the PDA to download data to an SD card, copying the 
audio or image files to the SD card may be the easiest method; then 
you can copy all associated files to your PC at once. Be sure to copy 
the files into the same folder that contains the downloaded .odn file.  
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Auto Report 
The Auto Report function automatically generates a report from the active 
measurement database. The Auto Report function is started by selecting Auto 
Report from the file menu. 

Report Configuration 

The items for reporting relate to the items that are usually viewed in the main 
software package: 

• Summary 

• Volts/Amps/Hz 

• Events 

• Harmonics – Bar graphs and Time plots 

• THD 

• Flicker 

• Power/Energy 

In addition, there are Common Settings. The Common Settings are used to: 

• Define the start and end dates and times of the report. 

• Select the types of graphs that are reported; a graph of the entire data 
set may be reported or this can be split into hourly, daily, or weekly 
sections for high-resolution data. 

• Save and Load defined reports – default templates are provided which 
may be loaded. 

• Select Output Format – The Auto Report is a PDF (ready-to-print 
format) or RTF (rich text format) file that can be edited by the user 
before printing. 

The standard report configuration files, Basic Report.ini, Intermediate 
Report.ini, and Comprehensive Report.ini templates can be loaded or the user 
can select each individual item for the report. Alternatively, an existing report 
configuration can be opened, edited, and saved with a new name (the default 
report configurations are set to read-only to prevent changes being saved). 
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Tagged Screens 

You can add tagged data you see on the screen in the View Recorded and 
Snapshot modes. You can tag as many different views as you want before 
creating the report. Power Analyze remembers what you have tagged until you 
exit the application or load a different data file. If you tag more than necessary, 
it is easy to unselect tagged items before you generate the report. 

To include tagged screens in a report: 

1. Configure the screen to your preference. 

Power Analyze captures the contents of the main area just as you see it. 
Use the tools, such as, view controls, zoom features, split/full screen, to 
adjust the display. 

2. Click Tag for Report at the bottom of the View Controls. 

3. In the dialog box, enter a heading to identify the data. 

By default, Power Analyze inserts the name of the active view. You can 
change this heading to be more specific and add a detailed description that 
appears in the report.  

4. Click OK. 

5. Continue to work and tag additional screens in order to include them. 

6. When ready to create the report, choose File>Auto Report. 

The tree item, Tag for Report, is visible when at least one screen is 
tagged.  

7. Click Tag for Report to display a list of all tagged items. 

8. Review the list to include in the report. You can use Ctrl+click to unselect 
or select an item. 

9. Click OK to create the report. 
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